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9.1 Writing the display unit’s Log Data to Excel

[Action Example]

Write the alarm log data stored in SRAM of display unit in an Excel file at 15:00 every day. 

This section describes the setting procedures for executing the above action (ACTION) as an example.

• Refer to the "GP-Pro Ex Reference Manual" for more details about alarms.

PC

(Node Name: PC1)

SRAM
GP3000

(Node Name: AGP1)

At 15:00 
everyday

Alarm

History
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[Setting Procedure]

10 Executing ACTION (page9-25) This step verifies that the log data of the display unit 
is written in the specified area of Excel when the 
preset trigger condition has become effective.

9 Transferring a Network Project File (page9-
24)

This step transfers a saved network project file to the 
display unit.

8 Saving a Network Project File (page9-23) This step saves the current settings as a network 
project file and reloads.

7 Verifying Setting Result (page9-21) This step verifies setting results on the setting 
content list screen.

6 Setting ACTION Node/Process Completion 
Notification (page9-19)

This step sets the name of an ACTION node and the 
alert setting whether it should be tuned on or off 

5 Setting Content of an Excel Template (page9-
10)

This step sets the following items:
• Log data type
• Data specification method

3 Registering Entry Nodes (page9-5) This step registers the PC and the display units as 
entry nodes.

1 Creating a Template (page9-4) This step creates a template to write log data on.

2 Starting 'Pro-Studio EX' (page9-5) This step starts 'Pro-Studio EX'.

4 Specifying an Excel Template and its Output 
Book (page9-6)

This step sets the following items:
• Specify a template
• Specify an output file



Writing the display unit’s Log Data to Excel

Pro-Server EX Reference Manual 9-4

9.1.1 Creating a Template

This step creates a template to write log data on.

1 Start Excel and create the sheet below in Sheet 1.

When you execute ACTION, log data will be written in.

2 Save the file on PC desktop naming "template.xlt".
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9.1.2 Starting 'Pro-Studio EX'

This step starts 'Pro-Studio EX'.

Refer to "3 Trial of Pro-Server EX" for details about starting method.

9.1.3 Registering Entry Nodes

This step registers the PC and the display unit connected with network as nodes.

Refer to "31 Node Registration" for details about entry nodes.

Entry node Setting item Setting example

PC
Node Name PC1

IP Address 192.168.0.1

Display Unit

Type GP3000 series

Node Name AGP1

IP Address 192.168.0.100

Node Name :PC1

IP Address :192.168.0.1

Node Name :AGP1

IP Address :192.168.0.100

Device/PLC Information
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9.1.4 Specifying an Excel Template and its Output Book

Specify the form template and output book created in (1).

Refer to "9.2 Setting Guide" for more details.

1 Click the [Feature] icon on the status bar.

2 Select [ACTION] from the tree display on the left of the screen, then click the [Add] button.

Setting item Setting content

Specify a Template Template File
C:\Documents and 
Settings\Administrator\Desktop\templete.xls

Output File

Folder Name C:\Documents and Settings\Administrator\Desktop

File Name GP log data.xls

Start with the output 
file displayed

Checked

Do not save the output 
file when ACTION 
runs.

Not checked
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3 Click the [ACTION Type] list button, and select "Create form using Excel.". 

Then, enter the name of ACTION to set in the [ACTION name] field. In this example, enter "GP Log Data".

4 Click the [Click here to set the ACTION parameter] button.

• [ACTION Name] can be an arbitrary name.
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5 Make settings regarding an Excel template and its output file.

1) Click the [Reference] button of [Template File] to set the template file "templete.xlt" which you created.

2) Click the [Reference] button of [Folder Name] and specify "Desktop" as a folder to save the output file.
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3) Set the file name "GP Log Data.xls" in the [File Name] field for the output file to set.

4) Check the [Start from Displayed State] check box.

• "%Y%M%D" is preset as "Year/Month/Date". For more details, refer to "37.1 Restrictions on 

Names".

• If you check [Start from Displayed State], you can read/write data with an output file displayed. 

This is useful if you need to confirm data immediately.
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9.1.5 Setting Content of an Excel Template

This step sets the content of the Excel template for writing log data in Excel.

The example below shows the setting of data write area (Log data area in GP) in a template.

Refer to "9.2 Setting Guide" for more details.

Setting item Setting content

Target Cell Range A4 to E13

Entry Node AGP1

Data Type Block 1 Data

Alarm Type Alarm History

Specification Method of File No. Current Data (Data in SRAM)

Action when cell gets full Clear and Overwrite

Trigger Condition Specified Time (15:00)

Target Cell Range
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1 Click the [Edit Template] button.

2 Set a data write area.

1) Click the [Log Data in GP Area] icon on Excel.

• Selecting [Log Data in GP Area] from [Excel Action] of the menu displays the same screen. 
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2) Click the cell range specify button of [Target Cell Range].

3) Drag the mouse to specify the area to use for data logging (cells A4 to E15). Then click the [OK] button.

4) Click the list button of [Node] and select "AGP1" as a data transfer source node.
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5) Select "Alarm Block 1 Data" for the data type and "Alarm History" for the alarm type.

6) Select "Current Data (SRAM/Real Time)" in [Specification Method of File No.].

7) Select "Clear and Overwrite" in [Action when cell gets full].
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3 Set trigger conditions. 

1) Click the [Trigger Condition Settings] tab.

The "Trigger Condition Settings" screen will appear.
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2) Click the [New Trigger Condition] button.

3) Click the [New Trigger Condition] button.

• You can create a button on the Excel sheet, and use this as a trigger condition to execute ACTION. 

Refer to "5.6 Creating Trigger Buttons in a Form" for details.
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4) Enter the trigger condition name "Read GP Log Data" in [Trigger Condition Name], and select "AGP1" in 

[Node Name] as a name of the data transfer source. 

5) Click the [Specified Time] button in the [Condition 1] tab, and enter "15" and "0" in [Specified Time]. Then 

click the [OK] button.
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6) Click the [Close] button.

7) In [GP Log Data Upload], click the blank line of [Trigger Condition] and select "ReadGPLogData" as a 

trigger condition.

8) Click the [OK] button.

This is the end of the content settings of an Excel template.
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4 Close 'Excel'.

The following dialog box will appear, asking you if you want to save changes before closing. Click the [Yes] 

button.

5 On the "Create form using Excel" screen, click the [OK] button.



Writing the display unit’s Log Data to Excel       

9-19                    Pro-Server EX Reference Manual                 

9.1.6 Setting ACTION Node/Process Completion Notification

This step sets the name of an ACTION node and the alert setting whether it should be tuned on or off when the 

ACTION is completed.

• ACTION Node : PC1

• Receive Notification: OFF

1 On the "Set ACTION Name/Parameter" screen, click the[Next] button.

2 Click the list button of [ACTION Node] and select "PC1" as a node where ACTION operates.
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3 Turn off the check box of [Receive Notification Exists], if checked.

4 Click the [Complete] button.

The "Set ACTION Node/Process Completion Notification" screen will disappear. On the left of the screen, the 

name of ACTION you set will appear.

This is the end of the settings of the ACTION node and process completion notification. 

• Do not check "Receive Notification Exists".
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9.1.7 Verifying Setting Result

This step verifies setting results on the setting content list screen.

1 Select the ACTION name "GP Log Data" from the tree display on the left of the screen.

Confirm that the setting content appears on the right of the screen.

• In case of the "Excel Report" ACTION, you cannot add, edit or delete trigger conditions from 

"Trigger Condition/Process List per ACTION". To change the settings, click the [Parameters 

Settings] button and change the settings in [Edit Template] on Excel.
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2 Select the trigger condition name "ReadGPLogData" from the tree display on the left of the screen.

Confirm that the setting content appears on the right of the screen.

This is the end of the verification of the settings.
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9.1.8 Saving a Network Project File

This step saves the current settings as a network project file and reloads to 'Pro-Server EX'.

Refer to "25 Saving" for details about saving a network project file.

• Path of network project file : Desktop\monitor.npx

• Title : EXCEL Report ACTION

9.1.9 Test Read

You can check if the settings are correct before transferring a created network project file to entry nodes.

When executing ACTION, the setting data is output to an output file. However, when executing a test read, it is 

reflected in a template file.

1 Click the [Feature] button.

2 Click "ACTION" from the tree display on the left of the screen, then click the [Edit] button.

3 On the "Set ACTION Name/Parameter" screen, click the [Click here to set the ACTION parameter] button.

4 On the "Create form using Excel" screen, click the [Edit Template] button.

• "Pro-Server EX" reads a created network project file, and then executes ACTION 
according to the settings in the file. The settings therefore need be saved in the network 
project file.

• Be sure to reload the network project file to 'Pro-Server EX'. If not, ACTION will not work.

• You do not necessarily have to perform a test read.

If you skip this, proceed to "9.1.10 Transferring a Network Project File".

• To perform a test read, it is necessary that 'Pro-Server EX', to which a created network 
project file has been loaded, is running. 
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5 With the ACTION area selected, click the [Test Read] icon.

The setup contents will be read in the template.

9.1.10 Transferring a Network Project File

This step loads a saved network project file to 'Pro-Server EX' and then transfers to entry nodes.

Refer to "26 Transferring" for details about transferring a network project file.

• Refer to "9.3 Restrictions" for details about the restrictions on test reads.

• Be sure to transfer a network project file. If not, ACTION will not work.
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9.1.11 Executing ACTION

This step verifies that enabling a trigger condition activates ACTION, opens an Excel book (file name: "GP error 

log.xls"), and then writes the log data of display unit in the specified location in Excel.

This is the end of the explanation of this ACTION.

• If error occurs, you can check the log in the Log Viewer. For more details, refer to "28.5 

Monitoring System Event Logs".

• If you want to achieve faster communication during ACTION, refer to "29 Tips for Faster 

Communication".
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9.2 Setting Guide

This section explains how to set the parameters of ACTION.

9.2.1 "Creating form using Excel" Screen

"5.1.2 Setting Guide"

9.2.2 "Log Data Upload" Screen

 "Action Settings" Tab

Setting item Setting content

Target Cell Range

Specifies the cell range to which data will be written.
Clicking the button can select the cell range on Excel.

• For the process on  how to select cell ranges, refer to "Action Area Settings" in "5.1.2 
Setting Guide".

• The useful function is available to check the specified cell range (Action Area). Refer to 
" Action Area List" in "5.1.2 Setting Guide".
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Node

Selects a node to read log data.

• Clicking the [...] button can retrieve or add entry nodes.
• Selecting "(Trigger-Source Node)" will select the entry node that has triggered the 

action. 

Data Type

Selects a log data type to write in a form.
Selectable log data depends on the type of display units.

SP-5B4*/WinGP / SP-5B10 / GP4000/LT4000 Series / GP3000 Sereies / LT3000
• CSV Data (Recipe)
• Alarm Block 1 Data - Alarm Block 8 Data
• GP Screen Data (Jpeg)
• Sampling Data
• GP-PRO/PB Logging data (compatible)
• GP-PRO/PB Trend graph data (compatible)
• GP-PRO/PB Sampling data (compatible)

• To upload line graph data, sampling data and logging data in a project file converted 
from 'GP-PRO/PB III for Windows', specify "compatible" of the corresponding data.

• You cannot write the "GP Screen Data (Jpeg)" log data to models without a CF/SD card 
slot.

• When using GP Screen Data (Jpeg) in Excel 2007, set Excel's Zoom Magnification to 
100%. If you save a template file with magnification not at 100%, the image size and 
position may shift.

• While the screen update load is high on the display unit and you run GP Screen Data 
(Jpeg), the display unit may fail to save the screen capture to JPEG and an error may 
arise.

GP Series
• Logging Data
• Trend Data
• Alarm Active
• Alarm History
• Alarm Log
• CSV Data (Recipe)
• Sampling Data
• Alarm Block 4 Data - Alarm Block 8 Data
• GP Screen Data (Jpeg)

• You cannot write the "GP Screen Data (Jpeg)" log data to models without a CF card slot.
• When using GP Screen Data (Jpeg) in Excel 2007, set Excel's Zoom Magnification to 

100%. If you save a template file with magnification not at 100%, the image size and 
position may shift.

• While the screen update load is high on the display unit and you run GP Screen Data 
(Jpeg), the display unit may fail to save the screen capture to JPEG and an error may 
arise.

Alarm Type
Other than the "GP Series", when you select "Alarm Block * Data", you can select the 
alarm type from "Alarm Active", "Alarm History", or "Alarm Log".

No. of JPEGs (Figures) When you select "GP Screen Data (Jpeg)", set the number of screens to read into the area.

Setting item Setting content
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Show CSV File Items

Check if you want to display the title content in Excel. 

• This does not appear if you select "CSV Data" or "GP Screen Data (Jpeg)". 

Specification Method of 
File No.

Selects where log data to read is stored. 

• Current Data (SRAM/Real Time)
Reads out current data stored in SRAM of the display unit.

• Latest Data (in CF-Card)
Reads out the latest data from those stored in a CF card (or SD card) of the display unit.

• Indirect Specification by Device Address (In CF-Card)
Reads out a specified number file from data stored in a CF card (or SD card) of the 
display unit.
In this case, the number is specified by device indirectly .
Specify Node, Device Name, and Device Address.

• Specify File No. (In CF-Card)
Reads out a specified number file from data stored in a CF card (or SD card) of the 
display unit.
In this case, specify the file number of the CF card (or SD card). 

Setting item Setting content
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Specification Method of 
Sampling Group No.

If you select "Sampling Data" for display units other than "GP Series", set how to specify a 
sampling group No.

• Indirect Specification by Device Address
Specify a sampling group No. by device indirectly. 
In this case, specify Node, Device Name, and Device Address/Symbol. 

• Specify Sampling No.
Fix and specify a sampling group No. 
In this case, specify a group No.

Setting item Setting content
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Action when cell gets 
full

Sets the action when the specified cells have got full.

• Clear and Overwrite
Clears data write cells to start writing from first.

• Scroll
Scroll up as a whole to write new data at the bottom. At this time, data at the top will be 
deleted.
You can specify this option when selecting "GP Screen Data" for the data type.

• New Sheet
Continues writing on a new sheet.
All the features being output on the sheet will be copied to the new sheet.

• Loop
Overwrites from top in sequence. 
You can specify this option when selecting "GP Screen Data" for the data type.

In creating a sheet, 
clear the specified cell 
range and then start.

Before copying a sheet from the template file, if data are written in the cell range of the 
sheet, clears the data and starts copying.

Setting item Setting content

A

C

B

D

When adding D to the full cell,

A

C

B

B

When adding D to the full cell,

C

D

A

C
B

D

When adding D to the full cell,

D
E

Further, adding E, 

Sheet1 Sheet2 Sheet2

A

C
B

D

When adding D to the full cell,

C
B
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 "Trigger Condition Settings" tab

Setting item Setting content

Action Area No. Displays No. allocated to each ACTION area by template.

New Trigger Condition
Displays the "Trigger Condition Settings" dialog box.
Click here to set a new trigger condition.

New Trigger Button
Displays the "Create Trigger Button" dialog box.
Refer to "5.6.2 Setting Guide" for more details.

GP Log Data Upload

Selects a trigger condition to read log data.
Click the blank line of [Trigger Condition] and then the list button to display the registered 
trigger condition. 

• When plural trigger conditions have been specified, satisfying at least one of those 
conditions executes ACTION.

• Clicking the [Edit] button can edit the specified trigger conditions.
• Clicking the [Delete] button deletes the specified trigger conditions.
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Clear Cells when the 
following condition is 
satisfied

Clears cells if a set trigger condition is satisfied. 
Click the blank line of [Trigger Condition] and then the list button to display the registered 
trigger condition. 

• When plural trigger conditions have been specified, satisfying at least one of those 
conditions clears cells.

• Clicking the [Edit] button can edit the specified trigger conditions.
• Clicking the [Delete] button deletes the specified trigger conditions.

Setting item Setting content
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9.3 Restrictions

 Combined Cells

Do not set an ACTION area on combined cells.

For example, if you set an ACTION area in the cells as shown below, correct operation cannot be guaranteed.

 Over-pasted ACTION Areas

When you over-paste plural ACTION areas of different size, read/write will be executed in the pasted order.

 Excel Window 

If the setting screen is hidden behind the Excel window, the screen and task tray windows will blink and notify the 

user. Blinking will stop automatically when the setting screen comes forward.

 Operation in ACTION area when error occurs

When you actually write/read in "GP Log" function and exceed the ACTION area, perform the common operation 

as follows:

1) When performing a test read/ a test write

Error screen is displayed.

2) When executing ACTION in runtime 

It will be recorded as ACTION error in the Log Viewer of the 'Pro-Server EX'.

 Functions which are not executed by a Test Read

The following functions are not executed by a Test Read.

"Action when cell gets full"

"Clear the cell range specified in creating a sheet to start"

 In the case of closing the displayed output book

If you have mistakenly closed an output book of Excel Report ACTION, follow these steps to open it again: 

Dragging and dropping the book to open will make it read-only and the start button etc. invalid. 

1. Double-click the output book.

2. When the following dialog box appears, select "No" to open it. 
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 Receive notification

You cannot set the receive notification which indicates the completion of ACTION.

 When setting “Trigger-Source Node”

When setting "Trigger-Source Node" at node in Excel Report action, node type and device are uncertain.

Therefore, the device address is displayed in red.But, it is no problem.

 Edit the output file

While Excel Report Action is executing, you can not edit the output file.

Therefore, it becomes very difficult to operate Excel at the setting in which the Trigger condition satisfies at a 

short cycle.Moreover, the following error message is displayed when the Action is executed during editing the 

output file.

 Save the output file Do not use

Do not use multiple Excel form actions to save output files to the same destination.

If you set the same destination for file outputs, Pro-Studio and Pro-Server EX may not be able to run.

 Restrictions on reading Alarm and Sampling Data on the CF Card

• In GP-Pro EX, use "yy/mm/dd" for the date format. When the CSV file on the CF card does not use "yy/mm/

dd" for the date format, the wrong date may be output.

When output to Excel, the date uses the "20yy/mm/dd" (or "19yy/mm/dd") format.

• When using a version of GP-Pro EX before V3.12, or a version of Pro-Server EX before V1.32, do not use the 

[Set number of files in destination folder on external storage] option in GP-Pro EX. You cannot read files 

stored [Alarm] or [SAMP**] sub-folders.

• If [Multiple Line Message Output (Save Alarm to CSV)] is enabled in GP-Pro EX alarm settings, when 

opening the CSV file, you will notice that messages with line breaks are output to the next cell down.

If [Multiple Line Message Output (Save Alarm to CSV)] is disabled, the message up to the line break only is 

saved to the CSV file.

 Restrictions on reading Alarm and Sampling Data in SRAM

• Regardless of the date format defined in GP-Pro EX, dates are handled with the "yy/mm/dd" format. When 

outputting to Excel, the date format is "20yy/mm/dd" (or "19yy/mm/dd").

• If [Multiple Line Message Output (Save Alarm to CSV)] is enabled in GP-Pro EX alarm settings, each line in 

a message is output to a different cell.
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If [Multiple Line Message Output (Save Alarm to CSV)] is disabled, the message up to the line break only is 

saved.

 About the 1500 row limit for Action Area settings

Exceeding 1500 rows for the Action Area could cause the action to run longer. If you use Device One Shot or  

Device Logging's text conversion, the action could take even longer.

 Restrictions on Copying or Cutting and Pasting the Action Area

When you paste the Action area using Ctrl+C & Ctrl+V or Ctrl+X & Ctrl+V, specify [Target Cell Range] for the 

copied Action area.

The Action area just after pasting remains the same [Target Cell Range] as that for the original Action area.

 Excel Auto Save Function

The Excel auto save function does not operate due to the Excel restrictions.To save automatically, create the Excel 

save macro using the following procedure and execute the created save macro by Action.

1 Open a template you want to save automatically using 'Pro-Studio EX'.
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2 Select "Macro" and "Record New Macro" from the "Tools" menu.

3 Enter the macro name "Macro1" and click the [OK] button.

Recording the macro starts.

4 Select "Save" from the "File" menu.

"Macro1" is recorded in the macro.



Restrictions

9-37                    Pro-Server EX Reference Manual                 

5 Select "Macro" and "Stop Recording" from the "Tools" menu.

Recording the macro is complete.

6 Select "Execution Sequence List" from the "Excel Action" menu.

7 Create the trigger condition save automatically.
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8 Select the created trigger condition and "Excel Operation Function".

9 Select "Execute Macro" and enter the macro name "Macro1".

10 Click the [OK] button.

11 Finish editing the template.

12 Save/Reload the setting contents.

According to the created trigger condition, the template is automatically saved.
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